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Rational Insight and Rational System 
Architect Integration 1

 Introduction 
This chapter provides instructions for producing two reports - a simple report showing 
list of definitions, and a sample visual, business report from Rational Insight using 
Rational System Architect repositories. Although you can generate report from live data 
sources as well, the scope of this chapter is to provide instructions for generating reports 
from data stored in a data warehouse. 

Generating a simple report from a data warehouse 
The figure shown below indicates the phases required to generate reports from a data 
warehouse and through live reporting. The scope of this chapter is to generate a report 
from the Data Warehouse. 

 
The overall tasks for generating reports from a data warehouse are as follows: 
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• Generate a XDC file using XML Data Configuration. 

• Model the physical database in the Data Manager by using the XDC file. 

• Extract the data from Rational System Architect through the ETL process. 

• Model the metadata and publish packages using the framework manager. 

• Publish the report using the browser. 

 

Generating the XDC file using XML Data Configuration 
Generate the XDC with the XML Data Configuration as follows: 

1. Start XML Data Configuration.  

2. Click File>Create Configuration. The New Configuration dialog is displayed. 

3. Enter a file path in the Location field and a name in the Name field. 

4. Click OK. 

Once the New Connection is created, you need to create the following items: 

• A Resource Group 

• Resource under the Resource Group 

• Data Mapping Templates 
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Creating Resource Group 

The XML Data Configuration gets loaded with a tree structure.  

1. Right click on Resource and select New> Resource Group. The new Resource 
Group dialog is displayed. 
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2.  Enter values for the Name and Description fields.  

3.  Chose the Authentication Type as None. Ensure that the client logged in to this 
machine has sufficient access to Rational System Architect encyclopedia repository 
from where the information is fetched. 

4.  Provide the REST URI in the Data Service field. The REST URI should be 
specified till the workspace level. 

5.  Click on Test Connection to validate the connection to the REST URI. Click 
Finish after testing the connection.  
 
A message box informs you if the connection is successful. If the connection is not 
successful, the message box displays a “Connection Refused” message. This means 
that the Rational System Architect REST Service is not running on the specified 
machine.  

Creating Resource under the Resource Group 

1.  Right click on the above-created Resource Group to create Resource under it. 

2.  Enter values for the Name and Description fields.  

3. Select the Locate using data service and click Next.  The encyclopedia tree panel 
is shown.  

4. Select the class node in the right side of the tree.  

5. Check the href and name checkboxes and click Next. 
6.  Select the Definitions URI and click on Next. The Definition tree panel is 

displayed.  

7. In the XML schema pane, select the type node.  

8. In the Element attributes pane check the href and name checkboxes and click 
Next. 

9.  Select the definition type to generate for your report and click Finish. 
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Creating Data Mapping Templates 

1. Right-click on the resource created above,  and select New> Data Mapping 
Table. The New Data Mapping Table dialog is displayed. 

2.  Enter values in the Name and Description field. You should enter suitable values, 
such as the name “SADefinitionMapping,” and description “Retrieval of Rational 
System Architect definitions through the REST API.” 

3. Click Next. 
4.  Under the Definitions node, select definition your are mapping click Next. The 

Create or Select a Data Mapping Table screen is displayed.  

5. Select Create a new template, if you do not have an existing template, and click 
Next. The Create a Data Mapping Template screen is displayed. 

6.  Enter values for the Name and Description fields and click on Next. 
7.  Define the XML data to Relation Table Mapping, as shown below.  
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8. Click Finish when you are done mapping. 

9.  On the newly created Data Mapping Template, right-click and select Open. The 
Data Mapping between the XML and the Relation Table is shown below. If errors 
arise, they are displayed at the top of the window. This step completes process of 
generating the XDC files. 
 

 

 Model the physical database in the Data Manager by using the 
XDC file  

Once the XDC file is created, the Data Manager is used to configure the physical 
database from which the information retrieved from Rational System Architect will be 
stored under the data warehouse. The steps for creating the Data Manager are as 
follows. 

The overall steps you need to take in Data Manager are as follows: 
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• Create /Open the Catalog. 

• Import the XDC files created through XML Data Configuration. 

• Import the Data from Rational System Architect into the Data warehouse. 

 

Create/Open the Catalog 

The catalog in Data Manager stores all the configuration information. 

1. To run the Data Manager, click the Start> Program Files> IBM Rational Insight> 
IBM Cognos 8> and select Data Manager. 

2. Click the Create a new catalog icon. You can also click Open an existing 
catalog if you have one.  

3. In the New Catalog dialog, enter values for the Name, Business name, and 
Description fields.  

4. Click Next. 
5. Choose the database server that you are using, as shown below in the example 

below.  
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6. Choose the authentication mechanism,  and enter values for the Server Name and 
Database Name fields.  

7. Click Test Connection. A message box displays test results.  
 
If it the test fails, an Error dialog is displayed with error information. 
If the test succeeds, a message box displays “Connection OK..” 

8. Click Finish when the connection test succeeds. 

9. Click OK to continue. 

Import the XDC files created through XML Data Configuration 

In the Data Manager, proceed as follows: 

1. Click Tools and select ODBC Administrator….  

2. The ODBC Data Source dialog is displayed.  
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3. Click the System DSN tab and click Add. The Create New Data Source dialog is 
displayed.  

4. Select IBM Rational Insight XML ODBC Driver and click Finish. 

5. Enter values in Data Source Name and Description fields.  

6. For the Configuration field, click Browse and locate the XDC you created 
through the XML Data Configuration wizard. 

7. Click on OK on all the opened dialogs. 

Import Data from Rational System Architect into the Data warehouse 

In the Data Manager, proceed as follows: 

1. Right-click Builds and JobStreams and select Insert Folder. 

2. Enter values for the Name, Business name, and Description fields and click 
OK. 

3. Create a folder hive under the folder you created above as necessary. 

4. Right-click on the Connections node to create new connection to the ODBC 
driver you created for the XDC file. 

5. Choose the Data source name, which you specified in the IBM Rational Insight 
XML Data ODBC Setup.  

6. Click on Test Connection to check the connection. If the connection succeeds, a 
“Connection OK” message is displayed. 

7. Click OK once the connection succeeds. 

8. Right-click on the connection node to create a new connection to the Rational 
System Architect Data Source, where the data retrieved from Insight will be stored.  

9. Specify the Data source name, which will be storing the data retrieved from 
Rational System Architect in Rational Insight. As shown below, the data retrieved 
from the Rational System Architect SQL server will be stored in the database 
name RISA.  
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10. Click Test Connection to validate the connection.  

11. In the Data Manager window, expand the Builds and JobStreams folder. 

12. Right-click on the ApplicationDefinition subfolder and select Insert Fact Build 
to initiate the data transfer from Rational System Architect to Rational Insight.   

Create a Data Source 
In the Data Manager Window, create a Data Source on the above-created Fact as 
described below.  

1. Right-click on the DataStream folder and select Insert Data Source. 

2. In the General tab, enter values for the Name and Description fields.  
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3. In the Query tab do the following tasks: 

ο Select the data source, which was specified in the IBM Rational Insight XML 
Data ODBC Setup. 

ο Expand the nodes and select the Rational System Architect data in which you 
are interested. Right-click on the selected node and click on Add table select 
statement. 
 

4. The Query tab now displays the Query statement, as shown below. 
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Optionally, click Test to check the data retrieval from Rational System Architect. 

5. If the data retrieval from Rational System Architect succeeds, click the Result 
Columns tab and click Refresh. The selected data will turn to the output as 
desired columns.  

6. Click OK to close the Data Source Properties panel.  
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Auto Mapping to Database  
In the Data Manager Window, create a Data Source on the above-created Fact as 
described below.  

1. Right-click on the Data Stream, and select Properties to perform the mapping. 

2. Click Auto Map. 

3. Right-click on Transformation Model, and select Mapping. The Rational System 
Architect data is transformed and mapped to the desired database selection. 

4. Click Auto Map, and select Create New Element as Attribute. 

5. Right-click on the Fact Delivery, and select Insert Relational Table Delivery. 

6. Enter a value in the Name field in the Table Delivery dialog.  

7. Click the Table Properties tab. 

8. Select connection as SADataRetrieved.  

9. Click on the button next to Table Name.  
Note: In Rational Insight , SADataRetrieved is the name of the connection to the 
database that will store the information retrieved from Rational System Architect. 

10. Specify a Table name in the Table Name field.  

11. Click Execute under the context menu displayed on the Fact Build. The data will 
be fetched from Rational System Architect and stored in the data warehouse. 

12. Click OK on the Execute Build dialog. If the data transfer from Rational System 
Architect is successful then amount of data transferred is shown in the console 
window.  

Framework Manager 
Once the data is the Rational Insight data warehouse, you use Framework Manager to 
model metadata and publish packages.  

Before starting Framework Manager, you need to ensure that the Data Warehouse is 
configured to the correct database and that the sign on user is created. By default, 
Rational Insight points to the “SAMPLEDW” data warehouse when it is installed.  

The instructions that follow point you to a “RISA” data warehouse, as an example. 
Therefore, you need change the data warehouse to “RISA.” Please refer to “Creating and 
changing Data Warehouse Signon” section (pg. 24) which describes how to change the 
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Data Warehouse and create a sign on user. 

To start Framework Manager proceed as follows: 

1. Click the Start> Program Files> IBM Rational Insight> IBM Cognos 8> and select 
Framework Manager. 

2. Execute each of the following tasks in the Framework Manager (each task is 
detailed in the sections that follow):  

ο Create or open a project. 
ο Create a new query subject on a project. 
ο Create and publish a new package. 

Creating or opening a project 

Rational Insight provides some out-of-the-box (OOB) projects. You can use the existing 
OOB projects and model your data or create a new project. The instructions in this 
section are for creating new project. A project is a set of files that define the metadata in 
one or more models. Models represent data source information. 

1. Click on the Create a new project… hyperlink in the Framework Manager. 

2. Enter values for the Project name field (for example, “SARationalInsight”), for 
the Location field, and click OK. 

3. Select a language in the Select Language field and click OK. 

4. In the Metadata Wizard, select Data Sources, since the data pulled from Rational 
System Architect is stored in the database. This data was pulled from Rational 
System Architect through the Data Manager.  

5. Click Next to choose the database under the selected data source. 

6. Select RISA from the data source list. This database stores the Rational System 
Architect data pulled through Data Manager.  

7. Click Next. 
8. Select dbo from the object list since the data from Rational System Architect was 

stored in this object, which was pulled through Data Manager.  

9. Click Next. The Metadata Wizard dialog shows the following options: 
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10. Click Import. Once the import is done, the project will be loaded.  
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Creating a new Query Subject on a Project 

Once the project is loaded, you can insert a new query, through the Query Subject 
context menu, as described below.  

1. Enter a name in the Name field and chose Data Source (Tables and Columns), 
since the data is being retrieved from the tables. 

2. Click OK. The New Query Subject Wizard is displayed. 

3. Select RISA from the data source list. The Run database query subject wizard 
checkbox should be checked. 

4. Click Next. The following options are displayed. 

5. Select the table from the data source list. 
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6. Click Next.  

 
The subsequent dialogs provide an option where you can modify the data through 
some logical expression and filtering. As an example, the dialogs below show how 
modify the data with the relevant information to your requirements.  
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A Filter Expression is shown below. 
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7. Click Next. The dialog below query subject, with the modifications you made for 

the example. 
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8. Click Test to validate the query against the Rational System Architect data 

warehouse. 

9. Click Finish to insert a query object in to the project. 

Creating and publishing a new Package 

Once the query object is inserted, you have to create a new package and publish it. 
Create the package as described below.  

1. Right-click on Packages node, and select Create> Package.  
2. Enter values for the Name, Description, and Screen tip fields. 
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3. Ensure that the query object selected below is included in the package in the screen 
displayed below. 

4. Select SQL server as the function sets. If you have stored the database in some 
other data source then select the appropriate data source. 

5. Click Finish. The following dialog is displayed. 
 

 
 
Now that the package has been created, it has to be published though the 
publishing wizard. 

6. Click Yes. In the dialog shown, note the folder location where the package will be 
published. You will need this folder location later when you publish the report.  

7. Click Next. The access control of user on the published package can be controlled 
through the dialog shown.  

8. Add the necessary user and click Next. 
9. Click Publish to publish the packages. 

10. Click Finish. If there are any errors or warnings found during package publishing, 
a Verify checkbox.   

 Publishing Reports 
Once the package is published, using the framework manager the report can be 
generated using the published package. The steps for generating the report is mentioned 
below 
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1. Open the browser window and enter the URI 
http://localhost:9080/insight/servlet.  

2. The screenshot shown below is displayed 

3. Click on Report studio in the menu shown below to open the report generating 
UI. 

4. Navigate to your desired folder and select the Package, which was published 
through the Framework Manager.  

5. Click on the SARationalInsightProject package, which was published in the 
Framework Manager; the package opens in the Reporting UI. 

6. Click on the Create a new report or Template to create new report. Click the 
Existing Template icon if you prefer to open an existing one. 

7. Chose the list item and click OK to produce a sample report with a list of 
definitions.  

8. The reporting UI opens with the list view. The query object is populated in the tree 
view in the explorer window. 

9. Traverse to the SARationalInsightQuery query object in the explorer window. 
This query object was created in the Framework manager. 

10. Switch to the Toolbox pane to drop the relevant controls on the report-editing 
window.  

11. Drag and drop the table control on to the editing window.  

12. Drag and drop the necessary fields from the SARationalInsightQuery query 
object in to the table. 

13. Click on the Run Report in the Report UI to generate the report. 

14. The output report is as shown below. You can export it to Microsoft Excel, 
Microsoft Word and other formats. 

 Creating and changing Data Warehouse Signon 
In Rational Insight, you have to change the data warehouse to point to point to the data 
warehouse where the Rational System Architect information is stored. You can do so 
with IBM Cognos Administration, as follows. 

1. Open the browser window and enter the following URI: 
http://localhost:9080/insight/servlet.  
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The IBM Cognos Connection screen  is displayed with the Public Folders tab 
selected.  

2. On the  toolbar, click on query drop-down field and select IBM Cognos 
Administrator. 

3. Click the Configuration tab. 

4. Click RISA in the data source list. It contains the table from where the information 
pulled from Rational System Architect is stored. 

5. Click on the properties icon, (left of the More… link.). 

6. Click the Connection tab. 

7. Click the Edit the connection string icon (right of the Connection string field). 
Ensure that the data warehouse RISA is selected as the Database name value. 
Select RISA if is not the currently selected data warehouse. 

8. After you configure the database, from the Configuration tab, click the New 
Signon icon to create a signon user. 

9. In the New Signon Wizard screen, enter a unique name in the Name field, and 
optionally, enter values in the Description, and Screen tip fields. Ensure this 
signon user is added to the RISA database in the SQL server. 

10. Click Next. 
11. Enter values for the User ID and Password fields, and click Next. The Select the 

users screen is displayed.  

12. To add users and groups that can use the signon, and click Add…. 

13. To choose from listed entries, click the appropriate namespace, and then select the 
check boxes next to the users, groups, or roles. 

14. Click the right-arrow button to add entries from the Available entries column to 
the Selected entries column. 

15.  Click OK. 

16. Click Finish. The new data source signon now appears in the Type field in the 
Connection tab. 
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2Generating a visual business report 

Introduction 
Before starting here, please read Section ‘Generating a simple report from a data 
warehouse’ section (pg. 3) which details all steps to create a simple report for Rational 
System Architect users using Rational Insight.  

This chapter guides you through real-world scenario, showing you how to use Rational 
System Architect to create a sample, visual business report with Rational Insight to 
analyze your business, as modeled in Rational System Architect. You can take similar 
steps to create Rational Insight reports for any other products that provide suitable data 
import mechanisms. 

The sample scenario here shows how a report author can create “Costing Dashboard 
Reports” (generated from Rational System Architect) using Rational Insight. Report 
users can then execute the report to see a visual summary of the relative costs spent by 
an organization in the Enterprise Architecture (EA) domains of Process, Technology, 
Application, and so on.  

Enterprise Architecture Domain Definitions 

Most of the data used for the sample report is available via the out of the box 
metamodel. However, some of the data is obtained from properties that need to be 
added to the metamodel. This is done by inserting code to your encyclopedia’s 
USRPROPS.TXT file. See the ‘Code to add to the USRPROPS.TXT file’ section (pg. 
30) for the code that you need to add.  

The sections below show and describe the Rational System Architect definitions used to 
create the sample report.  

Business Process data 
The process data will come from the Activity Based Costs inside a Business Process 
definition in Rational System Architect: 
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Application data 
The application data is taken from the Cost Center that is associated with an Application 
definition. 
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Organizational Unit data 
The organizational data comes from a summation of new properties added to an 
Organizational Unit definition. See the “DEFINITION "Organizational Unit"” section 
of the USRPROPS code (pg. 31). The properties added are Annual Salary, Annual 
Bonuses, and Other Contributions. 
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Location data 
The location data is a summation of the following for each location definition: 

 
Properties from “Project” and “Technology” definition types will also be used in this 
example, and are specified later in the document, where the property mappings are 
described.  

Code to add to the USRPROPS.TXT file 

To begin, you need to copy the code in step 4 below into your encyclopedia’s 
USRPROPS.TXT, file as follows: 

1. From the Rational System Architect Tools menu, and select Encyclopedia File 
Manager. 

2. Select the USRPROPS.TXT file and click “Export a file from the encyclopedia” 
icon.  

3. Open the USRPROPS.TXT file from the file onto which you exported it. 
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4. Copy the code below onto your USRPROPS.TXT file. 
 
Note: The “Energy Cost” definition is not provided out of the box, and therefore 
is added to the metamodel below (in the first line). The other definitions are 
provided out of the box, and are extended with additional properties. 

RENAME DEFINITION "User 1" TO "Energy Cost" 
 
DEFINITION "Application" 
{ 
 CHAPTER "Technologies" 
 PROPERTY "User"{   EDIT ListOf  "Organizational Unit" } 
 PROPERTY "Action By"{   EDIT DATE } 
 PROPERTY "Flag For Upgrade"{   EDIT BOOLEAN  DEFAULT "F" } 
 PROPERTY "Application Improvement Requirements"{   EDIT 
ListOf  "Requirement" } 
} 
 
DEFINITION "Organizational Unit" 
{ 
 CHAPTER "Costs" 
  LAYOUT { ALIGN OVER TAB COLUMNS 3 } 
 PROPERTY "Annual Salary"{   EDIT NUMERIC    LENGTH 10} 
 PROPERTY "Annual Bonuses"{   EDIT NUMERIC    LENGTH 10} 
 PROPERTY "Other Contributions"{   EDIT NUMERIC    LENGTH 10} 
} 
 
DEFINITION "Location" 
{ 
 CHAPTER "Costs" 
 PROPERTY "Water Rates"{   EDIT NUMERIC    LENGTH 10} 
 PROPERTY "Electricity Rates"{   EDIT NUMERIC    LENGTH 10} 
 PROPERTY "Yearly Rental Cost"{   EDIT NUMERIC    LENGTH 10} 
 PROPERTY "Purchase Cost"{   EDIT NUMERIC    LENGTH 10} 
} 
 
DEFINITION "Project" 
{ 
 CHAPTER "Costs" 
 PROPERTY "Approximate Cost"{   EDIT NUMERIC    LENGTH 10} 
} 
 
DEFINITION "Computer" 
{ 
 CHAPTER "Green Enterprise" 
 PROPERTY "Energy Supplier Cost"{   EDIT OneOf  "Energy Cost"    
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LENGTH 81} 
} 
 
DEFINITION "Energy Cost" 
{ 
 CHAPTER "Costs" 
 PROPERTY "Electricity Cost"{   EDIT NUMERIC    LENGTH 10} 
} 
 
DEFINITION "Hardware Processor" 
{ 
 CHAPTER "Green Enterprise" 
 PROPERTY "Energy Supplier Cost"{   EDIT OneOf  "Energy Cost"    
LENGTH 81} 
} 
 
DEFINITION "Server" 
{ 
 CHAPTER "Green Enterprise" 
 PROPERTY "Energy Supplier Cost"{   EDIT OneOf  "Energy Cost"    
LENGTH 81} 
} 
 
DEFINITION "Storage Device" 
{ 
 CHAPTER "Green Enterprise" 
 PROPERTY "Energy Supplier Cost"{   EDIT OneOf  "Energy Cost"    
LENGTH 81} 
} 
 
The USRPROPS code screen captures above apply to an encyclopedia where the 
TOGAF support is not enabled. If TOGAF is enabled in your encyclopedia, change the 
following types in USRPROPS accordingly: 
“Organizational Unit” to “Organization Unit” 
“Application” to “Application Component” 
 

Additionally, any references in this guide to “Application” or “Organization Unit” 
should be substituted accordingly in the property mappings. 

Generating a Report from live data 
To see the illustration of the overall steps to create and generate reports, see the section 
‘Generating a simple report from a data warehouse’ above (pg. 3).  
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To generating a report from live data, the overall steps are as follows: 

• Generate a XDC file using XML Data Configuration 

• Create or open an existing Resource Group 

• Create Data Mapping Templates 

• Model the physical database in the Data Manager by using the XDC file 

• Publish the report using the browser 

The sections that follow guide you through the above steps, as they relate to creating the 
sample business report.  

Generating the XDC file using XML Data Configuration 
Create or open an XML Data Configuration file using “XML Data Configuration” tool 
as explained in the ‘Generating the XDC file using XML Data Configuration’ section 
above (pg. 4).   

Creating or open an existing Resource Groups 
1. Create or use a Resource group specifying the REST URI in the Data Service field. 

The REST URI should be specified until the workspace level and be of the 
following format:  
http://localhost:8889/SARest/SQL/{database_instance}/{ency_
name}/1/  
 

2. In this example, we create a Resource group named “SystemArchitectDefinition” 
and use the REST URI: 
http://localhost:8889/SARest/SQL/ibm/Samples/1. 
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Creating Resource under the Resource Group 

In the created Resource Group, create Resources for the EA domains to be reported on. 
While creating the resources, use the radio button “Locate using Data Service,” and 
complete the creation using the following Resource URL’s for respective Resources. 

LocationDefinition:  
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http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Location 
 

ApplicationDefinition: 
http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Application  

OrganizationalUnitDefinition: 
http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Organizational-spa-Unit 
 

ProcessDefinition:  
http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Process 
 

ProjectDefinition: 
http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Project 
 

TechnologyServerDefinition:  
http://localhost:8889/SARest/SQL/ibm/Samples/1/Definitions/
Server 
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Ultimately, the configuration should look as follows: 
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Creating Data Mapping Templates 

Select each of the resources created above (for example ‘ApplicationDefintion’, 
‘LocationDefinition’, and so on), and create Data Mapping for each of them, as shown 
in Screens 1 – 6 below.  

Screen 1 – ApplicationMap 
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Screen 2 – LocationMap 
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Screen 3 – OrganizationlUnitMap 
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Screen 4 – ProcessMap 
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Screen 5 – ProjectMap 
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Screen 6 – TechnologyMap 
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Modeling the Physical Database in the Data Manager with the 
XDC file  

Once the XDC file is created, use the Data Manager to configure the physical database 
from which the information retrieved from Rational System Architect will be stored 
under the data warehouse.  

1. Create or Open the Catalog as follows: 
 

 
2. Next import the XDC files created through XML Data Configuration.  

3. Create a folder hive as shown below. 
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4. Create a connection to import data from System Architect into Data Warehouse. 
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5. In the Data Manager window, expand the Builds and JobStreams folder, and 

select the “Application” subfolder within “System Architect.”  

6. Select Insert Fact Build to initiate the data transfer from Rational System 
Architect to Rational Insight.   

7. Create a Data Source on the ‘Fact’ created above as shown in the screen below. 
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8. Use the Test buttons to check the data retrieval from Rational System Architect 

and complete creation of the Data Source.  

Auto Mapping to Database 
1. Right-click on the Data Stream, and select Properties to perform the mapping as 

explained in the ‘Creating Data Mapping Templates’ section above (pg. 7). 

2. Right click on the “Fact Delivery” and click on “Insert Relational Table Query” to 
create a Fact Delivery as explained in the ‘Auto Mapping to Database’ section (pg. 
15). Fill up the information as follows: 
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3. Select Connection, Table Name and other attributes as follows: 
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4. Click Execute under the context menu displayed on the Fact Build to fetch 

Application data from Rational System Architect into the data warehouse. 

5.  Repeat the above procedure for all sub-folders, viz. Location, Organization, 
Process, Project, and Technology.  
 
Use Screens 1 – 6 below as guides to create each Fact Delivery. 
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Screen 1 – SALocationDelivery (General tab) 
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Screen 2 – SALocationDelivery (Table Prooerties) 
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Screen 1 – SAOrganizationDelivery (Table Prooerties) 
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Screen 3 – SAProcessFact (Table Prooerties) 
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Screen 4 – SAProjectDelivery (Table Prooerties) 
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Screen 5 – SATechnologyDelivery (Table Prooerties) 

 
6. Close Data Manager after accepting and saving all changes. 
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Framework Manager 
Once the data is the Rational Insight data warehouse, you use Framework Manager to 
model metadata and publish packages, as explained in the ‘Framework Manager’ section 
above (pg. 15). 

Before starting Framework Manager, ensure that the Data Warehouse is configured to 
the correct database and that the sign on user is created. By default, Rational Insight 
points to the “SAMPLEDW” data warehouse when it is installed.  

The instructions that follow point you to a “RISA” data warehouse, as an example. 
Therefore, you need change the data warehouse to “RISA.” Please refer to “Creating and 
changing Data Warehouse Signon” section (pg. 24) which describes how to change the 
Data Warehouse and create a sign on user. 

Creating a new project named “SAInsight” 

Refer the ‘Creating or opening a project’ section above (pg. 16) for information on 
creating a new project. 

1. Select RISA from the data source list. This database stores the Rational System 
Architect data pulled through Data Manager.  

2. Select dbo from the object list since the data from Rational System Architect was 
stored in this object, which was pulled through Data Manager, and select the tables. 
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3. Complete the steps in the above dialog.  

4. In Framework Manager, select the project name “SAInsight” in the Left Hand 
Side tree view, and modify it to “Rational Insight Reporting Data Model (System 
Architect)”. Select the namespace RISA below it and change it to “System 
Architect.” 
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5. Expand the namespace “System Architect” to verify the Query Subjects.  

These Query Subjects have been obtained from the Physical Database. Therefore, create 
a Namespace “Physical Metadata” under “System Architect,” and move the query 
subjects to the namespace.  
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Creating a new Query Subject on a project  

1. Create another namespace “Consolidate View” under “System Architect,” where 
we will capture the logical model.  

2. Then select a Query Subject in the Physical Model, right-click and select “Merge In 
New Query Subject.” 
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3. Move the newly created query subject, 

SAApplicationDefinition_SAApplicationDefinition in the below snapshot, into the 
Consolidate View. 
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4. In the Consolidate View, rename the Query Subject to a logical name by which it 

will be referred in report creation, e.g. Rename 
“SAApplicationDefinition_SAApplicationDefinition” to “Application.” In the 
logical query subject, delete the properties not relevant or required for reporting, 
and rename the properties to logical names, as shown below (for example, rename 
“Related_CostCenter_TotalCost” to “Total Cost”. 
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5. Double-clicking “Application” query subject will show that the properties of the 

logical query refer the relevant properties of the physical query.  
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6. Repeat the same process for all the Query subjects in the “Physical Metadata” 

namespace to obtain the following Query Subjects in the Consolidate View. 
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Creating and Publishing a new package 

1. Once the query object is inserted, create a new package named “Reporting Data 
Model (IBM Rational System Architect)” and publish it, as shown below. 

 
2. Select only the Consolidate View into the package. 
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3. While publishing, you will see a message which essentially highlights that the 

“Physical Metadata” would be included in the published model since the 
“Consolidate View” queries depend on it, but will be hidden from users since 
reports should be decoupled from the “Physical Metadata”, and only run off 
“Consolidate View”  
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 Publishing Reports 
1. Once the package is published using the framework manager, reports can be 

generated using the published package. Here we describe the steps for generating 
the “Cost vs. EA Domain” summary reports. 

2. Open the browser window and enter the URI 
http://localhost:9080/insight/servlet.  

3. Launch Report Studio and select package “Reporting Data Model (IBM Rational 
System Architect)” 
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4. Select option to create a new report, of type Chart, select Pie, Donut among the 

Chart types, and select the right-most shaded Donut image. 

Report Design 

A word about the report design here – we are looking at reporting costs across multiple 
Query subject's corresponding to different domains, but the number and name of cost 
fields and other fields are not uniform. The next step is to create “Query” objects to 
unify the data from multiple sources, to be displayed in the report. 

1. Queries specify what data appears in the report. In Report Studio, you create and 
modify queries using Query Explorer Query Explorer provides an alternative way 
to modify existing reports or to author new reports. You can use Query Explorer 
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to perform complex tasks and other tasks that are more difficult to do in the report 
layout. 

2. For this, select the Query Explorer pane, Right Click on the Query Explorer 
Window and select “Manage Queries.” On the Query explorer, create Queries 
named after the EA domain areas, viz. Application, Location, Organization, 
Process, Project, and Technology. 

3. Select “Application” query, and double-click. From the “Insertable Objects” 
window on the Left side, expand “Application” Query Subject in the Consolidate 
View and select properties “Name” and “Cost.” Drag and drop the properties into 
the Data Item window on the right hand side. The “Application” query now has 
data items, which refer to respective properties in the “Application” Query Subject.  

4. Double click data item Cost to see that it refers [Consolidate 
View].[Application].[Cost] 
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5. Cancel the dialog, and keep the Data item “Cost” selected. 

6. On the “Properties – Data Item” pane, select the values for properties “Aggregate 
Function” and “Rollup Aggregate Function”  to “Total” and “Automatic” as 
shown below. This is required because we want to display aggregated cost for the 
Domain Query in the pie chart. 
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7. Select Data Item “Name” and change the value of its property “Expression” to 

‘Application’ – either in the “Properties-Data Item” pane or double-clicking the 
data item. 
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8. Note the sequence of Data Items used - we used Cost followed by Name, you can 

use any sequence (by dragging the Data Items up/down) but the sequence has to 
follow uniformly in the other queries for reasons explained later. 

9. Next, open the “Location” query in Query explorer. From the Consolidate View 
select the “Location” Query subject and drag and drop the properties “Yearly 
Rental Cost”, “Purchase Cost”, “Water Rates”, “Electricity Rates” and “Name” to 
make Data Items. 

10. Create a Data Item named cost, and enter into expression the sum of the 
expressions of “Yearly Rental Cost”, “Purchase Cost”, “Water Rates”, “Electricity 
Rates.” If you have followed the nomenclature used in this example it will look as 
follows: 
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11. The Data Item “Cost” now summarizes all the costs related to Location. Delete the 

“Yearly Rental Cost,” “Purchase Cost”, “Water Rates”, and “Electricity Rates” 
from the “Location” query.  

12. Again, on the “Properties – Data Item” pane for “Cost” Data Item, select the 
values for properties “Aggregate Function” and “Rollup Aggregate Function”  to 
“Total” and “Automatic”. 

13. Change the expression of “Name” data item to ‘Location’. Remember to keep the 
same sequence of “Cost” and “Name” Data Items as earlier. 

14. Repeat the same steps for all the other Queries, the expressions to be used are 
given below: 

Organization: 
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Cost = [Consolidate View].[Organization].[Annual 
Bonus]+[Consolidate View].[Organization].[Annual 
Salary]+[Consolidate View].[Organization].[Other Contributions] 
Name = ‘Organization’ 
 
Process: 
Cost = CAST([Consolidate View].[Process].[Total Cost], INTEGER) 
(The cast is required because “Total Cost” is character type 
field in SA and mapped accordingly.  
 
IMPORTATNT: Make sure all the “Total Cost” values in Rational System Architect 
are numeric. If the field holds any non-numeric values in Rational System Architect, the 
cast and the query will not work properly and the user will get an error when the report 
(developed using this query) is run. 
Name = ‘Process’ 
 
Project: 
Cost = [Consolidate View].[Project].[Approximate Cost] 
Name = ‘Project’ 
 
Technology: 
Cost= [Consolidate View].[Technology].[Electric Cost] 
Name=’ Technology’ 
 

Dropping a new Query 
At this stage, you need to drop a new query, as follows: 

1. Open Query Explorer, and drop a new Query named “Domain Summary”, drag 
and drop an “Union” from the “Insertable Objects” window to the side of 
“Domain Summary” query, and drag and drop the six queries viz. ‘Application’, 
‘Location’, ‘Organization’,’Process’,’Project’, ‘Technology’ to the right side of the 
union. 

2. This will cause the query relationship to be displayed as follows: 
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3. This signifies that ‘Domain Summary’ query is a summary of all the Domain costs 

summarized by type.  

4. “Domain Summary” does not have any data item yet. Double-click on the 
“Domain Summary” query in “Query Explorer” to bring up the “Data Items” 
pane. From the “Insertable Objects” pane, “Source” tab on the left hand side, drag 
and drop the “Cost” and “Name” properties under “Union 1” into the “Data 
Items” pane. “Domain Summary” query now has the required data items to report, 
and you can now use it in summary report creation. 

5. Select the Page Explorer Pane, and click Report Pages->Page1 to select the Report 
page for design. You may also navigate through the View menu. 

6. Select the Pie/Donut, and then set the values of ‘Query’ in the Properties pane to 
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‘DomainSummary’. 

7. On the top is the Title EditBox that says “Double Click to edit text”, set it to “Cost 
Vs EA Domain” 

8. Next select the ‘Insertable Objects’ window pane, and select Data Item tab. Locate 
‘Cost’ belonging to “Domain Summary” query and drop onto text box below 
‘Default Measure’ on the Design page. 

9. Drop ‘Name’ onto ‘Series (Pie Slices)’ 

10. Select ‘Default Legend Title’ on the Design page, and Set property ‘Default Title’ to 
‘No’. Then double click the text box and enter ‘EA Domain Legend’ 

11. Select the Pie/Donut again, and then set the values of the Properties pane as 
follows: 
Depth: 50 
Hole size (%): 25 
Chart Title->Title: Show 
Chart Title->AxisTitle: Hide 
Chart Labels -> Values: Outside slices with lines 
Chart Labels -> Pie Labels: Hide 
Chart Labels -> Value Representation: Percent 
Positioning-> Size & Overflow: Height=500, Width=700 
 

Executing the report 

To execute the report, proceed as follows: 

1. Click on menu Run->Run Report-HTML and you get a report like the following: 
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2. You can set different properties on the Pie Chart object, or use different report 

format to tune your report outputs. 

3. Click Save on the toolbar and save the report design as “Cost vs. EA Domain Pie 
Chart” in the package “Reporting Data Model (IBM Rational System Architect)”. 

4. Now save the report as “Cost vs. EA Domain Column Chart.” Select the Donut, 
right-click and press ‘Convert Chart’, select “Column” from the “Chart group” and 
chose “Column with 3D Visual Effect” on the right side. 

5. Click “OK” on the message shown. 

6. Execute the report to get an output as follows: 
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7. You can also try converting and saving this report as a “Bar Chart.” 

Summary 
This completes a sample report representing summary information in visual format. 
Based on your requirement, you can obtain necessary data from SA, and use relevant 
“Query Subject” and “Query” to obtain powerful visual reports to report and analyze on 
your business. 
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Contacting IBM Rational Software Support  

If you cannot resolve a problem with the self-help resources, contact IBM® Rational® 
Software Support.  

Note: If you are a heritage Telelogic customer, you can find a single reference site for all 
support resources at http://www.ibm.com/software/rational/support/telelogic/ 

Prerequisites  
To submit a problem to IBM Rational Software Support, you must have an active 
Passport Advantage® software maintenance agreement. Passport Advantage is the IBM 
comprehensive software licensing and software maintenance (product upgrades and 
technical support) offering. You can enroll online in Passport Advantage at 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html. 

• To learn more about Passport Advantage, visit the Passport Advantage FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quic
kguides.html. 

• For further assistance, contact your IBM representative. 
 
To submit a problem online (from the IBM Web site) to IBM Rational Software 
Support: 

• Register as a user on the IBM Rational Software Support Web site. For details 
about registering, go to http://www.ibm.com/software/support/. 

• Be listed as an authorized caller in the service request tool. 

http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/support/


 

Other information  
For Rational software product news, events, and other information, visit the IBM 
Rational Software Web site: http://www.ibm.com/software/rational/.  

Submitting Problems 
To submit a problem to IBM Rational Software Support: 

1. Determine the business impact of the problem. When you report a problem to 
IBM, you are asked to supply a severity level. Therefore, you need to understand 
and assess the business impact of the problem. 

To determine the severity level, use the following table. 

Severity Description 
1 The problem has a critical business impact: 

you are unable to use the program, resulting 
in a critical impact on operations. This 
condition requires an immediate solution. 

2  The problem has a significant business 
impact: the program is usable, but it is 
severely limited. 

3 The problem has some business impact: the 
program is usable, but less significant 
features (not critical to operations) are 
unavailable. 

4 The problem has minimal business impact: 
the problem causes little impact on 
operations or a reasonable circumvention to 
the problem was implemented. 

 
Describe the problem and gather background information. When you describe the 
problem to IBM, be as specific as possible. Include all relevant background information 
so that IBM Rational Software Support specialists can help you solve the problem 
efficiently. To save time, know the answers to these questions: 

• What software versions were you running when the problem occurred? 
• To determine the exact product name and version, use the option 

applicable to you:  
o Start the IBM Installation Manager and click File > View 

Installed Packages. Expand a package group and select a 
package to see the package name and version number.  
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o Start your product, and click Help > About to see the 
offering name and version number.  

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem?  

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components?  

Are you currently using a workaround for the problem? If so, be prepared to describe 
the workaround when you report the problem. 
Submit the problem to IBM Rational Software Support in one of the following ways: 

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/. In the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR) to describe the problem. 

• For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html. 

• You can also open an online service request by using the IBM Support 
Assistant. For more information, go to 
http://www.ibm.com/software/support/isa/faq.html. 

• By phone: For the phone number to call in your country or region, visit 
the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region.  

• Through your IBM Representative: If you cannot access IBM Rational 
Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. For complete contact information for each 
country, visit http://www.ibm.com/planetwide/.  
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Notices 
© Copyright IBM Corporation 1986, 2009. 

This information was developed for products and services offered in the U.S.A. IBM 
may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, or 
service is not intended to state or imply that only that IBM product, program, or service 
may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, program, or 
service. 

IBM may have patents or pending patent applications covering subject matter described 
in this document. The furnishing of this document does not grant you any license to 
these patents. You can send written license inquiries to: 

IBM Director of Licensing  
IBM Corporation  
North Castle Drive  
Armonk, NY 10504-1785 

For license inquiries regarding double-byte character set (DBCS) information, contact 
the IBM Intellectual Property Department in your country or send written inquiries to: 

IBM World Trade Asia Corporation  
Licensing  
2-31 Roppongi 3-chome, Minato-ku  
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS 
MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied 
warranties in certain transactions. Therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes 
are periodically made to the information herein; these changes will be incorporated in 
new editions of the publication. IBM may make improvements and/or changes in the 
product(s) and/or the program(s) described in this publication at any time without 
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notice. 

Any references in this information to non-IBM Web sites are provided for convenience 
only and do not in any manner serve as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product and use of 
those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.  

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs and 
other programs (including this one) and (ii) the mutual use of the information which has 
been exchanged, should contact: 

Intellectual Property Dept. for Rational Software  
IBM Corporation  
1 Rogers Street  
Cambridge, MA 02142 
U.S.A 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.  

The licensed program described in this document and all licensed material available for it 
are provided by IBM under terms of the IBM Customer Agreement, IBM International 
Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. 
Some measurements may have been made on development-level systems and there is no 
guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through extrapolation. 
Actual results may vary. Users of this document should verify the applicable data for 
their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products. 

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the names 
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of individuals, companies, brands, and products. All of these names are fictitious and any 
similarity to the names and addresses used by an actual business enterprise is entirely 
coincidental. 

Copyright license 

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, for 
the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested 
under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, 
or function of these programs. 

Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows:  

© (your company name) (year). Portions of this code are derived from IBM Corp. 
Sample Programs. © Copyright IBM Corp. 2000 2009.  

If you are viewing this information softcopy, the photographs and color illustrations may 
not appear. 

Trademarks 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. 
Other product and service names might be trademarks of IBM or other companies. A 
current list of IBM trademarks is available on the Web at “Copyright and trademark 
information” at www.ibm.com/legal/copytrade.html. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, 
other countries, or both. 

Other company, product or service names mentioned may be trademarks or service 
marks of others. 
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